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RZ/T2H Group 
Encoder I/F FA-CODER sample program 

Summary 
This document describes the RZ/T2H Encoder I/F FA-CODER® sample program package. 

For FA-CODER® communication protocol specifications and encoder specifications, contact Tamagawa 
Seiki Co., Ltd. 

 

Functionality Checked Device 
RZ/T2H Evaluation Board (RTK9RZT2Hxxxxxxxxx) 
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1. Package Contents 

This package contains the following contents. 

The RZ/T2H FA-CODER interface supports up to 12 axes, but the sample program supports only 1 axis of 

them. If you use with 2 axes or more simultaneously, modify the sample program to support required axes. 
 

1.1 Software 
• Source code 

No. Name Version number 
1 RZ/T2H FA-CODER sample program (CR52 ver. *) 2.0 
2 RZ/T2H FA-CODER sample program (CA55 ver. *) 2.0 

 
Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version 

that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective 
version. 

 
 

1.2 Documents 
No. Document name Version File name 

1 RZ/T2H Group Encoder I/F FA-
CODER Sample Program Release 
Note 

2.01 (j) r11an0784jj0201-rzt2h.pdf 
(e) r11an0784ej0201-rzt2h.pdf (this document) 

2 RZ/T2H Group FA-CODER Sample 
Program Application Note 

2.00 (j) r11an0783jj0200-rzt2h-fa-coder.pdf 
(e) r11an0783ej0200-rzt2h-fa-coder.pdf 
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2. File Structure 

The file structure and contents of this package are detailed below. 
Top 
├─ r11an0784jj0201-rzt2h.pdf 
├─ r11an0784ej0201-rzt2h.pdf 
└─ workspace 
   ├─ Software 
   │  ├─ iccarm 
   │  │  ├─ RZ_T2H_CR52_fac.zip  : RZ/T2H FA-CODER sample program set 
   │  │  │      CR52 ver. (IAR) 
   │  │  └─ RZ_T2H_CA55_fac.zip 
   │  │     ├─ RZ_T2H_CA55_0_fac : RZ/T2H FA-CODER sample program set 
   │  │     │     CA55 ver. (IAR) 
   │  │     └─ RZ_T2H_CR52_0_primary 
   │  │         : CPU_CTRL register setting program (IAR) 
   │  └─ gcc 
   │     ├─ RZ_T2H_CR52_fac.zip  : RZ/T2H FA-CODER sample program set 
   │     │      CR52 ver. (e2 studio) 
   │     └─ RZ_T2H_CA55_fac.zip 
   │        ├─ RZ_T2H_CA55_0_fac : RZ/T2H FA-CODER sample program set 
   │        │     CA55 ver. (e2 studio) 
   │        └─ RZ_T2H_CR52_0_primary 
   │            : CPU_CTRL register setting program (e2 studio) 
   └─ Documents 
      ├─ r11an0783jj0200-rzt2h-fa-coder.pdf 
      └─ r11an0783ej0200-rzt2h-fa-coder.pdf 

 
 

The file structure of the RZ_T2H_CR52_fac.zip and RZ_T2H_CA55_0_fac folder are shown below. 
Top folder 
├─ configuration.xml   : FSP Configuration data 
├─ ( Environment File Depending on Build Tool ) 
└─ src 
   ├─ hal_entry.c   : FA-CODER sample program 
   ├─ fac_main.c   : FA-CODER sample program 
   ├─ siochar.c    : SCI_UART sample program 
   ├─ siorw.c    : SCI_UART sample program 
   ├─ sio_char.h    : SCI_UART sample program 
   └─ drv 
      └─ fac 
         ├─ iodefine_fac.h  : FAC register definition file 
         ├─ r_fac_rzt2.c  : FAC driver file 
         ├─ r_fac_rzt2_config.h : FAC driver file 
         ├─ r_fac_rzt2_dat.h : FAC driver file 
         ├─ r_fac_rzt2_if.h  : FAC driver file 
         ├─ r_scie.c  : FAC driver file 
         └─ r_scie.h  : FAC driver file 
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The file structure of the RZ_T2H_CR52_0_primary folder is shown below. 
Top folder 
├─ configuration.xml    : FSP Configuration data 
├─ ( Environment File Depending on Build Tool ) 
└─ src  
   └─ hal_entry.c    : CA55 start-up program 



RZ/T2H Group Encoder I/F FA-CODER sample program 

R11AN0784EJ0201  Rev.2.01  Page 5 of 18 
Dec 13.24  

3. About FA-CODER Sample Program 

This section contains information necessary to use the complete set of FA-CODER sample programs. 
 

3.1 Software Information 
3.1.1 Base OS 
This sample program is OS-independent. 

 
3.1.2 Memory Size 
Memory size used by this sample program and FA-CODER driver is shown in following table. This table does 
not include memory size used by Flexible Software Package or C language libraries of the compiler, but for 
the DMAC driver portion which is used for the FA-CODER encoder interface. 

 
(1) CR52 ver. 

Items Memory Size 
EWARM 
[kBytes] 

e2 studio 
[kBytes] 

FA-CODER driver Code 7.0 6.3 
Data (with initial value) 0.0 0.0 
Data (without initial value) 2.7 2.7 
Constant Data 0.7 0.7 

DMAC driver for encoder interface*  Code 2.5 1.8 
Data (with initial value) 0.0 0.0 
Data (without initial value) 0.2 0.3 
Constant Data 0.0 0.0 

Sample program Code 4.3 4.9 
Data (with initial value) 0.0 0.0 
Data (without initial value) 0.6 0.6 
Constant Data 2.2 2.2 

Note: The DMAC driver are used for the FA-CODER encoder interface. They are called from inside of the FA-
CODER driver. 
The function using DMAC driver is enabled only in the CR52 version. 

 
(2) CA55 ver. 

Items Memory Size 
EWARM 
[kBytes] 

e2 studio 
[kBytes] 

FA-CODER driver Code 10.5 8.9 
Data (with initial value) 0.0 0.0 
Data (without initial value) 3.3 3.4 
Constant Data 1.1 1.4 

Sample program Code 6.9 8.8 
Data (with initial value) 0.1 0.0 
Data (without initial value) 0.6 0.6 
Constant Data 2.4 0.0 
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3.2 Hardware Information 
3.2.1 Device 

RZ/T2H 
 

3.2.2 Target Board 
(1) Board Name 

RZ/T2H Evaluation Board (RTK9RZT2Hxxxxxxxxx) 

 
(2) Setting of Target Board 

The target board configuration is as follows. 

SW1-6: OFF 

SW2-1: ON, SW2-2: OFF 

SW2-7: OFF 

SW2-8: OFF 

SW14-1: ON, SW14-2: OFF, SW14-3: ON, SW14-6: OFF (Set to xSPI1 boot mode) 

CN39: Short between 2-3 pins (Set VDD1833_2 to 3.3 V) 

CN40: Short between 2-3 pins (Set VDD1833_3 to 3.3 V) 

CN78: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3 V) 

Note: To use the target board RTK9RZT2H0CW1000BJ with connecting RS-485 board, power on/off by 
plugging and unplugging to the power-supply connector CN47 with keeping the slide switch SW16 on. 

 
(3) Used Pins of the Target Board 

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as 
follows.  

 
Channel Pin Name Pin Header Input/Output Voltage 

Domain 
Description 

FACODER0 RXDE00 CN2 #9 input VDD33 Data reception pin 
TXDE00 CN2 #7 output VDD33 Request output pin 
DEE00 CN2 #5 output VDD33 Drive/receive control pin 

FACODER1 RXDE01 CN2 #8 input VDD1833_3 Data reception pin 
TXDE01 CN2 #6 output VDD1833_3 Request output pin 
DEE01 CN2 #4 output VDD1833_3 Drive/receive control pin 

FACODER2 RXDE02 CN2 #17 input VDD33 Data reception pin 
TXDE02 CN2 #15 output VDD33 Request output pin 
DEE02 CN2 #13 output VDD33 Drive/receive control pin 

FACODER3 RXDE03 CN2 #18 input VDD33 Data reception pin 
TXDE03 CN2 #16 output VDD33 Request output pin 
DEE03 CN2 #14 output VDD33 Drive/receive control pin 

FACODER4 RXDE04 CN2 #27 input VDD1833_5 Data reception pin 
TXDE04 CN2 #25 output VDD1833_5 Request output pin 
DEE04 CN2 #23 output VDD33 Drive/receive control pin 

FACODER5 RXDE05 CN2 #26 input VDD1833_6 Data reception pin 
TXDE05 CN2 #24 output VDD1833_6 Request output pin 
DEE05 CN2 #22 output VDD1833_6 Drive/receive control pin 

FACODER6 RXDE06 CN3 #9 input VDD1833_3 Data reception pin 
TXDE06 CN3 #7 output VDD1833_3 Request output pin 
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Channel Pin Name Pin Header Input/Output Voltage 
Domain 

Description 

DEE06 CN3 #5 output VDD1833_3 Drive/receive control pin 
FACODER7 RXDE07 CN3 #8 input VDD1833_3 Data reception pin 

TXDE07 CN3 #6 output VDD1833_3 Request output pin 
DEE07 CN3 #4 output VDD1833_3 Drive/receive control pin 

FACODER8 RXDE08 CN3 #17 input VDD33 Data reception pin 
TXDE08 CN3 #15 output VDD33 Request output pin 
DEE08 CN3 #13 output VDD33 Drive/receive control pin 

FACODER9 RXDE09 CN3 #18 input VDD1833_2 Data reception pin 
TXDE09 CN3 #16 output VDD1833_2 Request output pin 
DEE09 CN3 #14 output VDD1833_2 Drive/receive control pin 

FACODER10 RXDE10 CN3 #27 input VDD1833_2 Data reception pin 
TXDE10 CN3 #25 output VDD1833_2 Request output pin 
DEE10 CN3 #23 output VDD1833_2 Drive/receive control pin 

FACODER11 RXDE11 CN3 #26 input VDD1833_2 Data reception pin 
TXDE11 CN3 #24 output VDD1833_2 Request output pin 
DEE11 CN3 #22 output VDD1833_2 Drive/receive control pin 
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3.3 Procedures on Development Environments: CR52 ver. 
3.3.1 Preparation before Executing the Sample Program 
This sample program communicates with a PC. The USB connection terminal on the target board is CN34. 
Select higher-numbered port from COM ports that appear at connecting the board with the host PC. 

The terminal software of the host PC is set as shown in the following table. 

Function Setting 
Communication method Asynchronous serial transmission/reception 
Sending / receiving order LSB first 
Transfer rate 19200 bps 
Character length 8 bits 
Stop bit length 1 bit 
Parity function None 
Hardware flow control None 

 
 

3.3.2 EWARM from IAR Systems 
(1) Build Environment 

IAR Embedded Workbench for ARM (EWARM) 

Version 9.60.2 + patch (EWARM_Patch_for_RZT2H_N2H_rev1.0) 

RENESAS FSP Smart Configurator (FSP SC) 2024-10 

RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0 

 

(2) Execution Environment ICE 

IAR I-jet 

 

(3) Build Procedure for Sample Programs 

The build procedure for the sample program is as follows. 

1 Extract RZ_T2H_CR52_fac.zip and copy the extracted source files to the desired location. 
2 Activate EWARM. 
3 Select [File] menu -> [Open Workspace].  
4 Open the extracted source file RZ_T2H_fac.eww. 
5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. * 

 
Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the 

EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New] 
button, specify a table string in each field, and press [OK]. 

 
Field String 

Menu text FSP Smart Configurator 
Command $RASC_EXE_PATH$ 
Argument --compiler IAR configuration.xml 
Initial directory $PROJ_DIR$ 

 
String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe. 
You can also start the FSP Smart Configurator directly from the command prompt by specifying the 
folder where it is installed. 
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6 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt, 

rzt_cfg, rzt_gen, script and .setting folders will be generated. 

 
 
7 When project generation is complete, close the Smart Configurator.  
8 Select [Rebuild All] from the [Project] menu of EWARM. 

The file Debug\Exe\RZ_T2H_fac.out is generated. 
 
(4) Sample Program Execution Procedure 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 Select [Project] menu -> [Download and Debug].  
2 Select [Debug] menu -> [Execute].  

 
(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.7 console commands in the RZ/T2H Group FA-CODER Sample Program Application Note.  
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3.3.3 e2 studio from RENESAS 
(1) Build Environment 

RENESAS e2 studio 2024-10 

Toolchain version: GNU ARM Embedded 12.2.1.arm-12-24 

RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0 

 

(2) Execution Environment ICE 

SEGGER J-Link v7.98c 

 

(3) Build Procedure of the Sample Program 

The procedure for building the sample program is as follows. 

1 Extract RZ_T2H_CR52_fac.zip and copy the extracted source files to the desired location. 
2 After launching e2 studio and moving to the workspace, click the [File] menu ->[Import] and select 

Existing project to workspace and click [Next]. 
3 On the project import screen, select the folder where the sample program was expanded as the root 

directory. 
4 Select a project, check Copy Project to Workspace, and click [Finish].  
5 Double-click the configuration.xml in the Project Explorer pane of e2 studio to open it.  
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6 Click Generate Project Content in the FSP Configuration pane of e2 studio.  
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated. 

 
 

7 Select [Project] menu -> [Build All]. 
The file Debug\RZ_T2H_fac.elf is generated. 

 
(4) Execution Procedure of the Sample Program 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].  
2 Click [Debug] to start downloading to internal RAM. 
3 Click [Run] menu -> [Resume] to run the sample program. 

 
(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.7 console commands in the RZ/T2H Group FA-CODER Sample Program Application Note. 
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3.4 Procedures on Development Environments: CA55 ver. 
3.4.1 Preparation before Executing the Sample Program 
This sample program communicates with a PC. The USB connection terminal on the target board is CN34. 
Select lower-numbered port from COM ports that appear at connecting the board with the host PC. 

The terminal software of the host PC is set as shown in the following table. 

Function Setting 
Communication method Asynchronous serial transmission/reception 
Sending / receiving order LSB first 
Transfer rate 19200 bps 
Character length 8 bits 
Stop bit length 1 bit 
Parity function None 
Hardware flow control None 

 
 

3.4.2 EWARM from IAR Systems 
(1) Build Environment 

IAR Embedded Workbench for ARM (EWARM) 

  Version 9.60.2 + patch (EWARM_Patch_for_RZT2H_N2H_rev1.0) 

RENESAS FSP Smart Configurator (FSP SC) 2024-10 

RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0 

 

(2) Execution Environment ICE 

IAR I-jet 

 

(3) Build Procedure for Sample Programs 

The build procedure for the sample program is as follows. 

1 Extract RZ_T2H_CA55_fac.zip and copy the extracted source files to the desired location. 
2 Activate EWARM. 
3 Select [File] menu -> [Open Workspace].  
4 Open the extracted source file RZ_T2H_CR52_0_primary -> RZ_T2H_CR52_0_primary.eww. 
5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. * 

 
Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the 

EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New] 
button, specify a table string in each field, and press [OK]. 

 
Field String 

Menu text FSP Smart Configurator 
Command $RASC_EXE_PATH$ 
Argument --compiler IAR configuration.xml 
Initial directory $PROJ_DIR$ 

 
String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe. 
You can also start the FSP Smart Configurator directly from the command prompt by specifying the 
folder where it is installed. 
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6 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt, 
rzt_cfg, rzt_gen, script and .setting folders will be generated. 

 
 
7 When project generation is complete, close the Smart Configurator.  
8 Select [Rebuild All] from the [Project] menu of EWARM. 

The file Debug\Exe\RZ_T2H_CR52_0_primary.sbd is generated. 
9 Select [File] menu -> [Open Workspace].  
10 Open the extracted source file RZ_T2H_CA55_0_fac → RZ_T2H_CA55_0_fac.eww. (Make sure to 

build the primary project first, as the RZ_T2H_CR52_0_primary.sbd file from the primary project will 
be referenced when opening.) 

11 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. 
12 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt, 

rzt_cfg, rzt_gen, script and .setting folders will be generated. 

 
 
13 When project generation is complete, close the Smart Configurator. 
14 Select [Rebuild ALL] from the [Project] menu of EWARM.   
 The file Debug\Exe\ RZ_T2H_CA55_0_fac.out is generated. 
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(4) Sample Program Execution Procedure 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 In the workspace of RZ_T2H_CR52_0_primary, select [Project] menu -> [Download and Debug]. 
RZ_T2H_CA55_0_fac project is launched. 

2 In the workspace of RZ_T2H_CR52_0_primary, select [Debug] menu -> [Execute]. CA55 start-up 
program is executed. 

3 In the workspace of RZ_T2H_CA55_0_fac, select [Debug] menu -> [Execute]. Sample program is 
executed. 

 
(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.7 console commands in the RZ/T2H Group FA-CODER Sample Program Application Note.  

 
 
 

3.4.3 e2 studio from RENESAS 
(1) Build Environment 

RENESAS e2 studio 2024-10 

  Toolchain version: 

 GNU ARM Embedded 12.2.1.arm-12-24 (Used in RZ_T2H_CR52_0_primary) 

 GCC ARM A-Profile (AArch64 bare-metal) 10.3.1.20210621 (Used in RZ_T2H_CA55_0_fac) 

RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0 

 

(2) Execution Environment ICE 

SEGGER J-Link v7.98c 

 

(3) Build Procedure of the Sample Program 

The procedure for building the sample program is as follows. 

1 Extract RZ_T2H_CA55_fac.zip and copy the extracted source files to the desired location. 
2 After launching e2 studio and moving to the workspace, click the [File] menu ->[Import] and select 

Existing project to workspace and click [Next]. 
3 On the project import screen, select the folder where the sample program was expanded as the root 

directory. 
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4 Select a project, check Copy Project to Workspace, and click [Finish].  
5 Double-click the configuration.xml of the RZ_T2H_CR52_0_primary project in the Project Explorer 

pane of e2 studio to open it.  
 

 
 

6 Click Generate Project Content in the FSP Configuration pane of e2 studio.  
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated in the RZ_T2H_CR52_0_primary 
project. 

 
 

7 In e2 studio’s Project Explorer pane, select RZ_T2H_CR52_0_primary, then go to the [Project] menu 
and choose [Build Project]. This will generate the Debug\RZ_T2H_CR52_0_primary.sbd file. 

8  Double-click the configuration.xml of the RZ_T2H_CA55_0_fac project in the Project Explorer pane of 
e2 studio to open it. (Make sure to build the primary project first, as the RZ_T2H_CR52_0_primary.sbd 
file from the primary project will be referenced when opening.) 
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9 Click Generate Project Content in the FSP Configuration pane of e2 studio.  
The rzt, rzt_cfg, rzt_gen, script, .settings folders will be generated in the RZ_T2H_CA55_0_fac project. 

 
 
10 Select [Project] menu -> [Build All]. 

The Debug\RZ_T2H_CA55_0_fac.elf file will be generated. 
 
(4) Execution Procedure of the Sample Program 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the 
RZ_T2H_CR52_0_primary project. 
Click [Debug] to start downloading to internal RAM. 

2 Click [Run] menu -> [Resume] to run the CA55 start-up program. 
3 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the 

RZ_T2H_CA55_0_fac project. 
4 Select 'No' when the dialog box inquiring about termination of the active debug session is displayed. 

 
 

5 If 'Proceed with launch' is displayed, select 'Yes'. 

6 Click [Debug] to start downloading to internal RAM.  

7 Click [Run] menu -> [Resume] to run the sample program. 
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(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.7 console commands in the RZ/T2H Group FA-CODER Sample Program Application Note. 
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Revision History 

Rev. Date 
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Page Summary 
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1, 5 
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Update the application note and release note version number. 
Update sample program version to 0.6. (It supports elctimer 
command emulating ELC by using CPU and DMA. Corrects 
response without connecting encoder to return error information. 
Revises to set cpsr register automatically on launching debugger 
of e2 studio.) 
Update file structure. (Add dmac folder.) 
Update memory size information. 
Update board name description. 
Revise e2 studio sample execution procedure by automatic cpsr 
set. Figures of console are updated. 

0.70 Apr 05.24 2 - 4 
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Update build environment and figures for CR52 ver. 
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Update sample program version to 2.0 (Supported FSP v2.2.0) 
Update the file structure. 
Update memory size information. 
Added xSPI1 boot mode to target board settings. 
Updated build environment to FSP v2.2.0 and replaced figures. 

2.01 Dec 13.24 2, 3 Update revision of the release note. 
Correct path name of the FSP SC in the sample program 
environment files to use default installation path. 

 

 



 

 

General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of 
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the 
use of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas 
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas 
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. 
Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products 
outside of such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you 
are responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020) 

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
version of a document, or your nearest sales office, please visit: 
www.renesas.com/contact/. 

Trademarks   
Renesas and the Renesas logo are trademarks of Renesas Electronics 
Corporation. All trademarks and registered trademarks are the property 
of their respective owners. 
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